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1 Einleitung 

Die Verwendung des PPCAN-Editors setzt eine Mindest-Qualifika-
tion des Benutzers hinsichtlich Hardware-Verständnis und Pro-
grammierkenntnissen voraus. 

Dieses Tutorial wendet sich daher an Besitzer eines PCAN-MIO-
Moduls, die komplexere Konfigurationen des Geräts benötigen und 
über belastbare Grundkenntnisse der Elektronik und Informatik 
verfügen. 

Zunächst sollte der für Kunden kostenlose PPCAN-Editor 2 anhand 
dieses Tutorials getestet werden. Die Häufigkeit von Verständnis-
problemen (technischer Natur!) beim Durcharbeiten des Dokuments 
kann möglicherweise als Entscheidungshilfe für einen zukünftigen 
Einsatz des Editors herangezogen werden. Im abschlägigen Fall 
bietet die PEAK-System Technik GmbH seinen Kunden einen Konfi-
gurationsservice gemäß detaillierter Spezifikation. 

1.1 Voraussetzungen für den Betrieb 

Zum sinnvollen Bearbeiten dieses Tutorials bzw. zum Lösen der 
Aufgaben steht ein Gerät PCAN-MIO inklusive Spannungsversor-
gung zur Verfügung. Dessen CAN-Busse sind über PCAN-PC-
Interfaces an einen Computer angeschlossen und korrekt terminiert. 

 zwei CAN-Busse über PEAK-Interfaces an den PC anschließen, 
mit je 500 kbit/s 

 Die Software PPCAN-Editor 2 ist installiert 

 Als CAN-Gegenstelle ist ein PCAN-View oder besser: ein PCAN-
Explorer auf dem PC installiert. Davon sind zwei Instanzen zu 
öffnen und mit jeweils einem CAN-Bus zu verbinden 
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Das Gerät PCAN-MIO stellt folgende Ressourcen zum Verknüpfen 
bereit: 

 Die Geräte-ID (4-Bit, 0..15 dez.) kann von außen per Drehschalter 
verändert werden 

 2 High-Speed-CAN-Kanäle über steckbare Transceiver-Module. 
Alternativ Low-Speed-, Single-Wire- und optoentkoppelte High-
Speed-Module sowie High-Speed-Module ohne Wake-Up-
Funktion verfügbar 

 CAN-Bitraten1 (10k; 20k; 33,3k; 47,6k; 50k; 83,3k; 95,2k; 100k; 
125k; 250k; 500k; 1M) 

 CAN-Nachrichten (11-Bit und 29-Bit) 

 1 RS-232-Anschluss (derzeit nur mit Sonder-Firmware nutzbar) 

 1 Ausgang 5 V / 200 mA 

 8 digitale Eingänge 

 8 digitale Ausgänge, 6 davon als Low-Side, High-Side oder 
Push-Pull umschaltbar, 2 davon PWM-fähig (nur High-Side) 

 6 analoge Eingänge (10 Bit, 0 - 10 V) 

 2 analoge Ausgänge (10 Bit, 0 - 10 V) 

 Wake-Up-Funktion über separaten Eingang 

 
1 Bitraten können frei eingestellt werden, die tatsächlichen Funktionen sind abhängig 

vom ausgestatteten Transceiver-Typ. 
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2 Begriff Konfiguration 

Die Mikrocontroller-basierten Geräte von PEAK-System bieten die 
Möglichkeit, alle verbauten Schnittstellen miteinander zu verknüp-
fen. Hierzu stellt die Firmware sogenannte Funktionsblöcke bereit, 
mit denen die Hardware-Ressourcen virtuell zu einer Konfiguration 
verschaltet werden. Zum Erstellen und Editieren von Konfiguratio-
nen stellt PEAK-System den PPCAN-Editor 2 für Windows mit jedem 
Gerät kostenlos bereit. 

Die so erstellte Datei mit der darin enthaltenen Konfiguration wird 
zunächst auf dem PC gespeichert, dann dem Gerät per Upload (via 
CAN) bekannt gegeben und dort nichtflüchtig gespeichert. Manche 
Geräte können mehrere Konfigurationen speichern: die jeweils gül-
tige wird mittels eines Wahlschalters selektiert. Der Wahlschalter 
bestimmt gleichzeitig die Geräte-ID und den Speicherort der Konfi-
guration innerhalb des nichtflüchtigen Speichers, aus dem die 
abzuarbeitende Konfiguration geladen wird. 

Die mit dem PPCAN-Editor 2 erstellten Dateien können mehrere 
Konfigurationen enthalten. Die Geräte-ID bestimmt dabei, welche 
davon bei Modulstart ausgeführt wird. Daraus ergibt sich z. B. die 
Möglichkeit, mehrere gleiche Geräte mit unterschiedlicher ID an 
einem CAN-Bus zu betreiben und die identische Konfigurations-
Datei auf alle Geräte zu laden. Die unterschiedliche ID sorgt dann 
dafür, dass jedes Gerät seine spezielle Konfiguration aus dem 
nichtflüchtigen Speicher lädt und dementsprechend seine Aufgabe 
ausführt. 

2.1 Möglichkeiten der Konfiguration 

Zur Verknüpfung von Schnittstellen gibt es die einfache Skalierung 
von Größen sowie die Methoden CAN-Gateway-Dienste, Default-
Werte, Funktionsblöcke, ereignisgesteuertes CAN-Senden, zeitge-
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steuerte Aktivitäten und Kennlinien. Bei Geräten mit nur einem 
CAN-Bus entfällt der Gateway-Dienst, und zeitgesteuerte Aktivitäten 
sind ebenfalls nicht mit jeder Hardware möglich. Die tatsächlich 
vorhandenen Ressourcen eines Geräts werden dem Editor durch 
eine spezielle Profildatei mitgeteilt, damit dieser die Verknüpfungs-
möglichkeiten entsprechend freischaltet bzw. einschränkt. Die 
verfügbaren Ressourcen können dem Handbuch der jeweiligen 
Hardware entnommen werden. (Aktuelle Handbücher stehen auf 
unserer Webseite als kostenloser Download zur Verfügung). 

2.2 Skalierung 

Das grundlegendste Mittel der Manipulation von Größen ist die 
Verwendung der vier Grundrechenarten. Dies wird mit den Parame-
tern SCALE und OFFSET gesteuert, die von der bekannten Gera-
dengleichung aus der Mathematik übernommen sind. Dabei ist der 
Parameter SCALE für Multiplikation (wenn > 1) bzw. Division (wenn 
< 1) zuständig. Der Parameter OFFSET bewirkt eine Addition (wenn 
> 0, positiv) bzw. Subtraktion (wenn < 0, negativ). Als neutrale Vor-
einstellung ist daher SCALE = 1 und OFFSET = 0 gewählt. 

2.3 CAN-Gateway-Dienste 

Eingehende Nachrichten auf dem einen CAN-Bus werden selektiv 
auf dem anderen CAN-Bus ausgegeben. Oder sie können auf dem 
gleichen CAN-Bus mit anderer ID ausgegeben werden (z. B. Umset-
zung 11-Bit <-> 29-Bit). Oder eine eingehende Nachricht kann das 
Versenden einer beliebigen anderen Nachricht auslösen, wobei 
beide Nachrichten inhaltlich nichts miteinander zu tun haben. 
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2.4 Default-Werte 

Durch hier festgelegte Parameter kann der Zustand des Moduls 
nach dem Einschalten bestimmt werden, wie z. B. die Bitrate des 
CAN-Busses, Aktivierung eines 5 V-Ausgangs für Sensorenversor-
gung, den logischen Zustand von Leitungen, Leuchtdioden, etc. 

2.5 Funktionsblöcke 

Falls die einfache Manipulation von Messgrößen etc. mittels SCALE 
und OFFSET nicht ausreicht, stehen sogenannte Funktionsblöcke 
mit erheblich komplexeren Möglichkeiten zur Verfügung. Dies reicht 
vom Umsetzen per X/Y-Tabelle über Hysteresefunktionen, Delays, 
Zähler, Tiefpass-Filter, diverse mathematische und logische 
Operatoren bis zum komplexen PIDT1-Regelkreis. Funktionsblöcke 
können sequentiell oder bedingt abgearbeitet werden. 

2.6 Ereignisgesteuertes Aussenden von CAN-
Nachrichten 

Falls CAN-Nachrichten nur bei bestimmten Gelegenheiten gesendet 
werden sollen, steht außerdem ein Repertoire an Triggerbedingun-
gen zur Verfügung. CAN-Nachrichten können außerdem von extern 
angefordert werden (RTR-Nachrichten). 

2.7 Kennlinien 

Hier lassen sich 2 bis 31 X-Werte als Eingangsparameter eintragen, 
denen je ein Y-Wert als Ausgangsparameter zugeordnet ist. Für den 
Wertebereich zwischen zwei X-Werten wird das Y-Ergebnis linear 
interpoliert. Anders ausgedrückt: So lassen sich (wie bei der Skalie-
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rung) SCALE und OFFSET für bis zu 31 Abschnitte eines Wertebe-
reichs einzeln einstellen. Damit ist es möglich, Kurvensegmente in 
ihrer Steigung zu beeinflussen, um z. B. Plateaus zu definieren oder 
nichtstetige Funktionen nachzubilden. 
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3 Aufgabenliste 

Durch die Lösung der hier aufgelisteten Aufgaben lässt sich ein 
Überblick über die vielfältigen Möglichkeiten der PCAN-Hardware 
(hier speziell des PCAN-MIO-Moduls) erhalten. 

 1a) Weiterleiten aller Nachrichten von CAN-0 nach CAN-1 
(Gateway) 

 1b) Definieren von CAN-Nachrichten 

 1c) Umsetzen der definierten Nachrichten von CAN-0 nach  
CAN-1 

 1d) Kombination 1a und 1c 

 1e) Zyklisches Senden einer Nachricht auf CAN-1 mit Signalen 
von CAN-0 

 1f) Scale und Offset 

 1g) Exportieren einer Symboldatei 

 1h) Erstellen eines einfachen Instrument-Panels 

 2a) Einlesen der digitalen Eingänge und versenden in einer CAN-
Nachricht 

 2b) Setzen der digitalen Ausgänge entsprechend einer 
empfangenen CAN-Nachricht 

 2c) Einlesen der analogen Eingänge und versenden in einer 
CAN-Nachricht 

 2d) Setzen der analogen Ausgänge entsprechend einer 
empfangenen CAN-Nachricht 

 2e) Schalten des 5 V-Ausgangs 

 3a) CAN-Signal mit Funktionsblock-Kennlinie bearbeiten 

 3b) Schwellwert mit Hysterese 
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 3c) Senden nur, wenn sich ein Signal ändert 

 4a) Setzen der CAN-Bitrate (Defaultwerte) 

 5a) Ausgabe der Modul-ID (Diagnose) 

 5b) Ausgabe der Firmware-Version (Diagnose) 

 6) CAN-Nachrichten auf Anforderung 

 7) Der Sleep-Mode (Energiesparen) 

 8a) Multiplexer-Nachricht automatisch senden 

 8b) Multiplexer-Nachricht auf Anfrage senden 

 9) Bonusaufgaben 
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4 Lösungswege mit 
Erläuterungen 

Weitere Information zur Benutzung des PPCAN-Editor 2 finden Sie 
in der Hilfe, die Sie im Programm über das Menü Hilfe oder die 
Taste F1 erreichen.  

4.1 Aufgabe 1a: Weiterleiten aller 
Nachrichten von CAN-0 nach CAN-1 
(Gateway) 

1. Starten Sie den PPCAN-Editor 2 und gehen Sie folgender-
maßen vor. 

2. Verbinden Sie den PPCAN-Editor 2 mit einem PEAK-
Interface z.B. PCAN-USB. Wählen Sie den Menüpunkt CAN > 
Connect und wählen dann die entsprechende Hardware aus. 

In der Statuszeile des PPCAN-Editors (unten links) erscheint 
das von ihnen ausgewählte CAN-Netz. 

 

3. Wählen Sie den Menüpunkt Transmit > Detect Modules aus 
um zu prüfen, ob das PCAN-MIO-Modul am CAN-Netzwerk 
gefunden werden kann. 

Das Dialogfenster Active Modules erscheint. In diesem 
werden Statusinformationen des PCAN-MIO-Moduls 
angezeigt. 
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z. B. wird im Feld Module No die eingestellte Geräte-ID angezeigt (hier: 0). Im Feld 
Version wird die Firmware-Version angegeben. 

4. Legen Sie eine leere Konfigurationsdatei an, wählen Sie den 
Menüpunkt File > New aus. 

5. Legen Sie eine neue Konfiguration innerhalb der Konfigura-
tionsdatei an. Wählen Sie hierzu den Menüpunkt Edit > New 
Configuration aus. 

Es wird nach der zu konfigurierenden Hardware gefragt. Der 
PPCAN-Editor ist für eine Vielzahl von konfigurierbaren 
PCAN-Geräten mit unterschiedlichsten Ressourcen ausge-
legt. Für jede konfigurierbare PCAN-Hardware gibt es daher 
eine Liste der verfügbaren Ressourcen. 

 

6. Wählen Sie das Profil PCAN-MIO aus und bestätigen Sie mit 
Ok. 
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Hinweis: Ab der Seriennummer 100 arbeiten PCAN-MIO-
Module mit einer intern veränderten Konfigurationsstruktur. 
Dem entsprechend müssen Sie bei der Erstellung einer neuen 
Konfiguration im PPCAN-Editor das passende Hardwareprofil 
auswählen: „PCAN-MIO“ bis Seriennummer 99, „PCAN-MIO 
(32-Bit)“ ab Seriennummer 100.  

Neue I/O-Funktionen, die nur im Hardwareprofil „$1B: PCAN-
MIO (32-Bit)“ zur Verfügung stehen, können nicht auf 
Konfigurationen übertragen werden, die auf dem Profil 
„$14: PCAN-MIO“ basieren. 

Neben dem Tab General erscheint ein neuer Tab mit dem 
Namen der Konfiguration Config0 I/O. Im Navigator-Bereich 
links im Fenster ist ein Icon Config0 entstanden. 

 

7. Doppelklicken Sie auf das Icon Config0 am linken Bildrand. 

Es öffnet sich ein neues Konfigurationsfenster. Hier können 
komplexere Verknüpfungen von Ressourcen vorgenommen 
werden, die über das einfache Zuweisen und Skalieren 
hinausgehen. 

8. Wählen Sie den Tab Default values for data objects aus, 
öffnen Sie das Kontexmenü (rechte Maustaste) und wählen 
Add Record. 
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Um Werte in die entsprechenden Tabellenzeilen einzutra-
gen, aktiviert man den Eingabefokus der markierten Zelle 
mit der Taste F2, durch langsames Klicken oder durch 
Schreiben des Wertes. 

9. Tragen Sie in die Tabellenzeile folgende Werte ein: 

 

 I/O Function: 70h SpecialOut (eine virtuelle Modelresource) 

 I/O No: Routing 0 to 1 All 

 Default value: 1 (Aktivieren dieser Funktion) 

 Information: Eine Beschreibung, was diese Zeile macht 

In diesem Fall werden alle Nachrichten, die auf CAN-0 
hereinkommen, 1:1 auf CAN-1 ausgegeben. So erhalten bei-
spielsweise Steuergeräte im Crashbereich eines Fahrzeugs 
die gleichen Informationen, können aber im Schadensfall 
den restlichen Bus nicht blockieren. 

10. Die Konfigurationsdatei wird als Projekt Aufgabe 1a auf dem 
PC gespeichert. Klicken Sie hierzu auf den Menüpunkt File > 
Save As. 
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11. Übermitteln Sie die Konfigurationsdatei an das PCAN-MIO-
Modul über den CAN-Bus (Upload). Wählen Sie hierzu den 
Menüpunkt Transmit > Send Configuration aus (oder 
wählen Sie das entsprechende Icon aus). 

 

Wichtiger Hinweis: Am oberen Fensterrand in der Toolbar 
muss der Eintrag Config0 in der Listbox eingestellt sein. 

 

Während des Upload laufen im Output-Window des PPCAN-Editors 
verschiedene Statusmeldungen durch. 

Die Status-LED des PCAN-MIO-Moduls blinkt während der Übertra-
gung und Verarbeitung der Konfigurationsdatei unrhythmisch. 
Sobald die Status-LED kurz rot aufblitzt, wurde die Konfiguration 
verarbeitet und ein automatischer Geräte-Reset durchgeführt. 
Danach blinkt die Status-LED mit 1 Hz und das PCAN-MIO-Modul ist 
mit seiner neuen Konfiguration betriebsbereit. 
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4.2 Aufgabe 1b: Definieren von CAN-
Nachrichten 

Anlegen einer leeren Konfigurationsdatei. 

1. Wählen Sie den Menüpunkt File > New aus. 

Es erscheint ein leeres Fenster mit den globalen CAN-
Objekten für alle später in der Datei enthaltenen Konfigura-
tionen. Falls eine Datei mehrere Konfigurationen mit unter-
schiedlichen CAN-Objekten enthält, müssen -alle- zunächst 
hier definiert werden. Sie werden später selektiv in die ver-
schiedenen Konfigurationen importiert. 

Im Fenster ist bereits ein CAN-Bus definiert: Bus_0, unter 
dem man globale CAN-Objekte hierarchisch anlegen kann. 

2. Doppelklicken Sie auf den Namen Bus_0 und tragen den 
neuen Namen ein. Wählen Sie aus der DropDownliste die 
Default-Bitrate 500 kbit/s aus. Die Auswahl ist nur informativ 
und hat keinen Einfluss. 

 

 Busname: MIO_CAN-0 

 Bitrate: 500 kbit/s 

 Information: Eine Beschreibung, was diese Zeile macht 

Um Routen zu können, braucht man den zweiten CAN-Bus 
des PCAN-MIO-Moduls. 
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3. Öffnen Sie dazu das Kontextmenü des Fensters (den 
Mauszeiger auf den weißen Fensterhintergrund und die 
rechte Maustaste betätigen) und wählen Sie Add new Bus. 

 

4. Doppelklicken Sie auf den Bus-Namen und tragen Sie den 
neuen Namen ein. Wählen Sie die Default-Bitrate 500 kbit/s 
aus Die Auswahl ist nur informativ und hat keinen Einfluss. 

 

 Busname: MIO_CAN-1 

 Bitrate: 500 kbit/s 

 Information: Eine Beschreibung, was diese Zeile macht 

Legen Sie nun auf beiden Bussen mindestens je eine 
Nachricht mit mindestens je einem Signal an. 

5. Wählen Sie dafür im Kontextmenü die entsprechende Zeile 
(rechte Maustaste) und den Punkt Add new Symbol (erzeugt 
eine neue CAN-Nachricht) aus und tragen Sie dann die 
Parameter der Nachrichten ein: 
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 Symbolname: Quellnachricht und Zielnachricht 

 CAN-ID: 0x100 (11-Bit-ID) und 0x00000200 (29-Bit-ID) 

 DLC: 8 (die Anzahl der Datenbytes) 

 Extended: Entscheidet über 11-Bit-ID oder 29-Bit-ID 

 Enable: Ja, beide Nachrichten sollen verwendet werden 

 RTR: Nein, die Nachricht soll -nicht- nur auf Anforderung 
gesendet werden 

6. Wählen Sie im Kontextmenü die CAN-Nachrichten (rechte 
Maustaste) und den Punkt Add new Variable (erzeugt ein 
neues CAN-Signal) aus und tragen Sie dann die Parameter 
der Signale ein: 

 

 Variablenname: Quellsignal und Zielsignal 

 Unit: Bei physikalischen Größen sinnvoll (nur informativ) 

 Bit length: 8 (beide Signal je 1 Byte lang, Wertebereich 0..255) 
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 StartByte: 0 (StartByte/StartBit geben an wo die Variable 
beginnt) 

 StartBit: 0 

 Signed: nein, zunächst keine negativen Werte  

 Byte Order: Intel-Format (LSB in Byte 0/Bit 0,  
MSB in Byte 1/Bit 7) 

Der Rahmen der beiden CAN-Nachrichten ist damit festgelegt, aber 
ihr Inhalt ist noch keiner Datenquelle zugeordnet. Dazu muss eine 
Konfiguration erzeugt werden. 

4.3 Aufgabe 1c: Umsetzen der definierten 
Nachrichten von CAN-0 nach CAN-1 

Legen Sie eine neue Konfiguration innerhalb der Konfigura-
tionsdatei an. 

1. Wählen Sie den Menüpunkt Edit > New Configuration aus. 

Es wird nach der zu konfigurierenden Hardware gefragt. 

2. Wählen Sie das Profil PCAN-MIO aus und bestätigen Sie mit 
Ok. 

Neben dem Tab General erscheint ein neuer Tab mit dem 
Namen der Konfiguration Config0 I/O. Im Navigationsfenster 
am linken Bildrand ist ein Icon Config0 entstanden. 

Die global definierten CAN-Busse, -Nachrichten und 
-Signale sollen alle in dieser Konfiguration verwendet 
werden. Sie müssen also importiert werden. 

3. Holen Sie den Tab Config0 I/O in den Vordergrund. Wählen 
Sie im Kontextmenü (rechte Maustaste) für jeden Bus Add 
defined bus aus. 
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Die global bereits definierten CAN-Busse werden mitsamt 
der enthaltenen Nachrichten und der 8-Bit-Variablen in die 
Konfiguration übernommen. 

4. Weisen Sie den definierten Bussen eine CAN-Kanalnummer 
der Hardware zu. 

 

 Channel No.: 0 und 1 (zuweisen der Hardware-CAN-Kanäle) 

5. Tragen Sie die Parameter für die Nachrichten ein. 
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 Direction: Receive (Nachricht wird vom Bus empfangen) und 
Transmit (Nachricht wird auf dem Bus ausgeben) 

 Enable: Ja, die Nachricht soll empfangen bzw. übermittelt 
werden 

 Period: 0 (Nur bei Zielnachricht: die Nachricht wird nicht zyklisch 
gesendet) 

6. Tragen sie die Parameter für die Signale ein. 

 

 I/O-Function: FFh 32bit Variable (das eingehende Quellsignal 
wird in eine 32-Bit-Variable geschrieben und von dort auch 
wieder ausgegeben) 

 I/O-Number: Verwenden der 32-Bit-Variablen #0 

 Scale: 1 (keine Verstärkung/Abschwächung der Daten, 
Multiplikation *1) 

 Offset: 0 (keine Anhebung/Absenkung des Wertebereichs, 
Addition 0) 
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 Enable: Ja, dieses Signal (innerhalb der Nachricht) soll verwen-
det werden 

Die beiden Nachrichten müssen Sie jetzt dem Gateway-
Dienst übergeben, damit dieser sie von CAN-0 nach CAN-1 
umsetzt. 

7. Doppelklicken Sie das Icon Config0 am linken Bildschirm-
rand an. 

Es öffnet sich das Fenster Config0. 

8. Wählen Sie den Tab Message Gateway aus, öffnen Sie das 
Kontexmenü (rechte Maustaste) und wählen Add Record 
aus. 

Es erscheint eine Tabellenzeile, die eine CAN-Nachricht 
routet. Tragen Sie die Parameter ein. 

 

 Source Bus: MIO_CAN-0 

 Source-Message-ID: ID 0x100 (11-Bit-Format) 

 Destination-Bus: MIO_CAN-1 

 Destination-Message-ID: ID 0x00000200 (29-Bit-Format) 

 Enable I/O-Function: CC (Const), das Routing soll immer aktiv 
sein 

 Enable I/O-Number: 1 

 Mode: Direct copy (immer dann wenn was hereinkommt) 
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9. Speichern Sie die Konfiguration als Aufgabe 1c auf ihrem 
PC. 

10. Übermitteln Sie die Konfigurationsdatei an das PCAN-MIO-
Modul über den CAN-Bus (Upload). 

 

 

Wird auf CAN-0 eine CAN-Nachricht mit der ID 0x100 zum PCAN-
MIO-Modul gesendet, wird der Nachrichteninhalt auf CAN-1 in einer 
Nachricht mit der ID 0x00000200 ausgegeben. Andere Nachrichten 
werden ignoriert. 

4.4 Aufgabe 1d: Kombination 1a und 1c 

Es sollen alle Nachrichten von CAN-0 nach CAN-1 ohne 
Änderungen durchgereicht werden, außer der Nachricht 0x100. 
Sie soll weiterhin nach ID 0x00000200 umgesetzt werden. 

1. Öffnen Sie die Aufgabe 1c und speichern diese unter 
Aufgabe 1d auf ihrem PC. 
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2. Doppelklicken Sie das Icon Config0 am linken Bildschirm-
rand an. 

Es öffnet sich das Fenster Config0. 

3. Wählen Sie den Tab Default values for data objects aus, 
öffnen Sie das Kontexmenü (rechte Maustaste) und wählen 
Add Record aus. 

Alles von CAN-0 nach CAN-1 routen, außer der als Parame-
ter angegebenen ID. 

 

 I/O-Funktion: 70h Special Out 

 I/O-Number: Routing 0 to 1 excluding (route alles von CAN-0 
nach CAN-1 außer 0x100) 

 Default Value: 256 (0x100 diese ID nicht routen. Die Eingabe 
erfolgt dezimal) 

Hinweis: Die Routingfunktionen explicit und excluding un-
terstützen nur 11-Bit-IDs. Dabei bedeutet explicit, dass nur 
definierte Nachrichten geroutet werden und excluding bedeutet, 
dass definierte Nachrichten vom Routen ausgespart werden. 

4. Speichern Sie die Konfiguration als Aufgabe 1d auf ihrem 
PC. 

5. Übermitteln Sie die Konfigurationsdatei an das PCAN-MIO-
Modul über den CAN-Bus (Upload). 



PCAN-MIO – Konfigurations-Tutorial 
 

27 

 

 

Wird auf CAN-0 eine CAN-Nachricht mit einer ID ≠ 0x100 zur MIO 
gesendet z.B. 0x101, dann wird diese genau so auf CAN-1 ausgege-
ben. 

Wird auf CAN-0 eine CAN-Nachricht mit der ID = 0x100 zur MIO 
gesendet, dann wird der Nachrichteninhalt auf CAN-1 in einer 
Nachricht mit der ID 0x00000200 ausgegeben. 

Hinweis: Diese Funktionalität ist sehr nützlich, wenn ein neues 
Steuergerät in einen bestehenden Fahrzeugbus eingeschleift 
werden soll und dieses Steuergerät CAN-Signale in einem 
anderen Layout/einer anderen Formatierung (neue CAN-
Datenbasis) benötigt. Zudem kann der Rest des Fahrzeugbus-
ses unverändert durchgeschleift werden. 
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4.5 Aufgabe 1e: Zyklisches Senden einer 
Nachricht auf CAN-1 mit Signalen von 
CAN-0 

Durch Eintragen einer Sendeperiode für die Nachricht 
0x00000200 wird ein zyklisches Senden der Information auf 
CAN-1 erreicht. Die benötigten Daten werden weiterhin der 32-
Bit-Variablen #0 entnommen, die von CAN-0 befüllt wird. Bleibt 
die Nachricht aus, wird der letzte bekannte Inhalt wiederholt. 

1. Öffnen Sie die Konfiguration der Aufgabe 1c und speichern 
diese unter Aufgabe 1e auf ihrem PC. 

2. Öffnen Sie den Tab Config0 I/O und legen Sie für die 
Sendenachricht eine Zykluszeit fest. 

 

 Period: 250 ms (die Nachricht wird ab jetzt zyklisch gesendet) 

3. Speichern Sie die Konfiguration als Aufgabe 1e auf ihrem 
PC. 

4. Übermitteln Sie die Konfigurationsdatei an das PCAN-MIO-
Modul über den CAN-Bus (Upload). 



PCAN-MIO – Konfigurations-Tutorial 
 

29 

4.6 Aufgabe 1f: Scale und Offset 

Mit den Parametern SCALE und OFFSET können Werte vom 
CAN-Bus mit den Grundrechenarten bearbeitet werden, ohne 
einen Funktionsblock zu definieren. Beispielweise kann ein 
steigender 8-Bit-Wert (Rampe) invertiert werden (0 -> 0xFF, 0xFF 
-> 0). Dazu wird der Originalwert aus der Empfangs-Nachricht in 
eine 32-Bit-Variable geschrieben und diese beim Schreiben auf 
die Sendenachricht mit SCALE -1 und OFFSET 255 beaufschlagt. 
Es ist genauso möglich, den Empfangswert gleich umzurechnen 
und erst dann in eine Variable zu schreiben. Man muss aber 
darauf achten, dass der umgerechnete Wert -immer- in die 
Variable passt. 

1. Legen Sie eine leere Konfigurationsdatei mit File > New an. 

2. Dem bereits existierenden CAN-Bus werden 2 Symbole 
(CAN-Nachrichten) hinzugefügt. 

 

3. Jede Nachricht erhält noch eine 8-Bit-Variable (CAN-Signal). 

 

Legen Sie eine neue Konfiguration an und importieren Sie 
die CAN-Objekte. Die Objektparameter werden folgender-
maßen eingetragen: Die Nachricht mit der ID 0x100 wird 
empfangen und das darin enthaltene Signal wird in die 32-
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Bit-Variable #0 geschrieben. Die Nachricht mit der ID 0x200 
wird zyklisch gesendet (100 ms). Das darin enthaltene Signal 
wird der 32-Bit-Variablen #0 entnommen, invertiert (SCALE= 
-1) und um 255 angehoben (OFFSET=255). 

 

 

4. Speichern Sie die Konfiguration als Aufgabe 1f auf ihrem 
PC. 

5. Übermitteln Sie die Konfigurationsdatei an das PCAN-MIO-
Modul über den CAN-Bus (Upload). 

Die in der Empfangs-Nachricht 0x100 enthaltenen x-Werte (Byte #0) 
werden als y = (-1)*x+255 bzw. y = 255-x in der Sende-Nachricht 
ausgegeben. Aus einer steigenden Rampe (zunehmende x-Werte) 
wird eine fallende Rampe (abnehmende y-Werte). 
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4.7 Aufgabe 1g: Exportieren einer 
Symboldatei 

Für Besitzer eines PCAN-Explorers (Art.-Nr. IPES-005028) ist es 
komfortabel, die Inhalte von CAN-Nachrichten zu dekodieren und 
lesbar darzustellen. Dazu dient eine Symboldatei, dass vom PPCAN-
Editor aus die CAN-Daten generiert und als Datei abgespeichert 
werden kann. Die Aufgabe 1f dient als Grundlage. 

PPCAN-Editor: 

1. Wählen Sie den Tab General aus, um die Datenbasis 
auszuwählen. 

2. Wählen Sie den Menüpunkt File > Export > Into Symbol File 
aus. 

 

3. Speichern Sie die Symboldatei als Aufgabe 1g auf ihrem PC. 

Es erscheint ein Fenster mit den zu exportierenden CAN-
Objekten. Klicken Sie auf die Objekte die Sie exportieren 
wollen oder klicken Sie auf Select All. 
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4. Klicken Sie auf Export. Die Symboldatei wird erstellt. 

PCAN-Explorer: 

5. Klicken Sie zum öffnen der Symboldatei auf File > Open und 
zum aktivieren auf File > Apply. 

 

Im PCAN-Explorer erscheint nun im Feld Data das übertra-
gene Byte in dezimaler Darstellung und mit dem korrekten 
Variablennamen. 
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4.8 Aufgabe 1h: Erstellen eines einfachen 
Instrument-Panels 

Um als Besitzer eines PCAN-Explorers (Art.-Nr. IPES-005028) den 
Empfangswert bequem grafisch editieren zu können, kann ein 
sogenanntes Instrumenten-Panel angelegt werden. Dazu muss das 
entsprechende PCAN-Explorer Add-in "Instruments Panel" (Art.-Nr. 
IPES-005088) installiert sein. 

Die beiden Variablen aus Aufgabe 1g erscheinen außerdem als 
CAN-Objekte im Explorer-Fenster Project Browser an der rechten 
Seite. Sie lassen sich beispielsweise in Verbindung mit einem 
Instrument (Control) nutzen, um die Bedienung bzw. Lesbarkeit von 
Signalen zu erleichtern. 

 

Beispielsweise kann das CAN-Signal Original mit einem Schie-
beregler sehr einfach manipuliert werden. Auch die Verwendung 
in Skripten zur Test-Automation ist eine mögliche Anwendung 
dieser Objekte. 

1. Wählen Sie den Menüpunkt Tools > Instruments Panel > 
Create horizontal Slider Control. 
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Es wird ein leeres Panel mit einem waagerechten Schiebe-
regler erstellt. 

 

2. Weisen Sie diesem Instrument jetzt eine CAN-Variable zu. 

Dies geht per Drag&Drop: Man zieht (drag) mit der linken 
Maustaste die Variable „Original“ aus dem Projekt Browser 
über das Instrument und lässt sie dort fallen (drop). 

 

3. Setzen Sie in den Eigenschaften die Werte der Nachricht 
0x100, wählen Sie hierzu Properties > Data > Value Setting. 
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Damit das Ergebnis der Konfiguration komfortabel dargestellt wird, 
fügen Sie dem Panel ein Anzeigeinstrument Create Value Indicator 
hinzu und belegen es mit der CAN-Variablen Invertiert. 

4. Wählen Sie den Menüpunkt Tools > Instruments Panel > 
Create Value Indicator, positionieren Sie das entstandene 
Anzeigeinstrument beispielsweise unterhalb des Schiebe-
reglers, weisen Sie die CAN-Variable „Invertiert“ durch 
Drag&Drop dem Anzeigeinstrument zu. 

5. Klicken Sie mit der rechten Maustaste entweder auf das 
Instrument Original oder auf Invertiert und klicken Sie Run 
Mode zum aktivieren des Panels. 
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Durch Betätigen des Schiebereglers nimmt das erste Byte der 
Nachricht 0x100 Werte zwischen 0 und 255 an. In der Nachricht 
0x200 wird der Wert umgekehrt angezeigt. Die in der Empfangs-
Nachricht 0x100 enthaltenen x-Werte (Byte #0) werden als y = (-
1)*x+255 bzw. y = 255-x in der Sende-Nachricht ausgegeben. Aus 
einer steigenden Rampe (Original, zunehmende x-Werte) wird eine 
fallende Rampe (Invertiert, abnehmende y-Werte). 

6. Speichern Sie das Panel als Aufgabe 1h.ipf auf ihrem PC. 
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4.9 Aufgabe 2a: Einlesen der digitalen 
Eingänge und versenden in einer CAN-
Nachricht 

Das PCAN-MIO-Modul verfügt über diverse Hardware-Eingänge und 
-Ausgänge, die beliebig miteinander verknüpft werden können. 

Um den logischen Zustand des digitalen Eingangs Din-0 zu 
setzen, müssen Sie eine Verbindung entweder zu GND oder 
Vbat herstellen. Dazu kann z. B. eine Drahtbrücke verwendet 
werden. 

1. Legen Sie eine leere Konfiguration mit File > New an. 

2. Dem bereits existierenden CAN-Bus wird ein Symbol 
(CAN-Nachricht) hinzugefügt. 

 

3. Die Nachricht erhält eine 1-Bit-Variable (CAN-Signal für den 
digitalen Eingang Din-0). 

 

4. Legen Sie eine neue Konfiguration an und importieren die 
CAN-Objekte. 

Tragen Sie die Parameter für die Nachricht ein. Die Nach-
richt mit der ID 0x100 wird von dem PCAN-MIO-Modul 
gesendet. 
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 Direction: Transmit 

 Enable: Ja 

 Period: 250 

Und das darin enthaltene Signal wird mit dem Zustand des 
digitalen Eingangs Din-0 belegt. 

 

 Direction: Transmit (das PCAN-MIO-Modul sendet den Status 
des digitalen Eingangs DIN-0) 

 I/O-Funktion: DIn-Level 

 I/O-Number: 0 

 Scale: 1 

 Offset: 0 

 Enable: Ja 

5. Speichern Sie die Konfiguration als Aufgabe 2a auf ihrem 
PC. 

6. Übermitteln Sie die Konfigurationsdatei an das PCAN-MIO-
Modul über den CAN-Bus (Upload). 
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Die CAN-Nachricht mit der ID 0x100 wird zyklisch gesendet und ent-
hält im ersten Byte den logischen Zustand des digitalen Eingangs 
Din-0. 

Ist an diesem Eingang nichts angeschlossen, wird eine 1 übertra-
gen, denn die Hardware enthält intern einen PullUp-Widerstand 
(kann konfiguriert werden!). Wird der Eingang mit GND verbunden 
wechselt der Wert auf 0. 

4.10 Aufgabe 2b: Setzen der digitalen 
Ausgänge entsprechend einer empfange-
nen CAN-Nachricht 

Um im folgenden Beispiel den digitalen Ausgang Dout-0 kontrol-
lieren zu können, ist ein Spannungsmessgerät (Voltmeter bzw. 
DMM) an diesen Ausgang anzuschließen. Alternativ kann eine 
Leuchtdiode mit passendem Vorwiderstand (z. B.: ca. 1,5 kOhm) 
gegen GND angeschlossen werden. 

1. Öffnen Sie die Konfiguration der Aufgabe 2a und speichern 
diese unter Aufgabe 2b auf ihrem PC. 

2. Benennen Sie im Tab General das CAN-Signal Din0 in Dout0 
um. 

3. Tragen Sie im Tab Config0 I/O folgende Werte für die CAN-
Nachricht und das CAN-Signal ein. 

 

 Direction: Receive 

 I/O-Function: 00h DOutLevel 
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 Enable: Ja 

Das PCAN-MIO-Modul ist mit verschiedenen Treibern für die 
digitalen Ausgänge ausgestattet: 

 a) Die Ausgänge 0..7 können Vbat-Pegel oder einen offen-
Zustand annehmen (High-Side-Treiber). Hierfür sind die I/O-
Nummern Do H0 bis Do H7 anzugeben 

 b) Die Ausgänge 2..7 können GND-Pegel oder einen offen-
Zustand annehmen (Low-Side-Treiber). Hierfür sind die I/O- 
Nummern Do L2 bis Do L7 anzugeben 

 c) Die Ausgänge 2..7 können Vbat-Pegel oder GND-Pegel 
annehmen (PushPull-Treiber). Hierfür sind die I/O- Nummern Do 
HL0 bis Do HL7 anzugeben 

4. Speichern Sie die Konfiguration als Aufgabe 2b auf ihrem 
PC. 

5. Übermitteln Sie die Konfigurationsdatei an das PCAN-MIO-
Modul über den CAN-Bus (Upload). 

Wird eine Nachricht 0x100 an die PCAN-MIO gesendet, in der 
Byte0/Bit0 = 1 ist, wird der digitale Ausgang Dout-0 aktiviert.  

 Im Fall a) erhält man einen Vbat-Pegel 

 im Fall b) einen GND-Pegel 

 im Fall c) einen Vbat-Pegel 

Wird eine Nachricht 0x100 an das PCAN-MIO-Modul gesendet, in 
der Byte0/Bit0 = 0 ist, wird der digitale Ausgang Dout-0 deaktiviert.  

 Im Fall a) erhält man einen offen-Zustand 

 im Fall b) einen offen-Zustand 

 im Fall c) einen GND-Pegel 
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4.11 Aufgabe 2c: Einlesen der analogen 
Eingänge und versenden in einer CAN-
Nachricht 

Für nachvollziehbare Ergebnisse sollten Sie im folgenden 
Beispiel am analogen Eingang Ain 0 eine Spannungsquelle 
anlegen. Dazu kann beispielsweise ein 10 kOhm-Potentiometer 
zwischen Vbat und GND angeschlossen werden, an dessen 
Schleifer eine variable Spannung zur Verfügung steht. Die 
Auflösung des A/D-Wandlers ist 10-Bit. Das CAN-Signal muss 
also dementsprechend 2 Bytes breit sein (sofern man Scale = 1 
verwendet). 

1. Öffnen Sie die Konfiguration der Aufgabe 2a und speichern 
diese unter Aufgabe 2c auf ihrem PC. 

2. Ändern Sie im Tab General die Länge der CAN-Nachricht 
auf 2 Byte, benennen das CAN-Signal in Ain0 um und 
erhöhen die Bitlänge auf 10. 

 

3. Weisen Sie im Tab Config0 I/O dem CAN-Signal folgende 
Werte zu. 

 

 I/O-Function: 90h AIn-Level 



PCAN-MIO – Konfigurations-Tutorial 
 

42 

 I/O-Number: AIn 0 

 Enable: Ja 

4. Speichern Sie die Konfiguration als Aufgabe 2c auf ihrem 
PC. 

5. Übermitteln Sie die Konfigurationsdatei an das PCAN-MIO-
Modul über den CAN-Bus (Upload). 

Die Nachricht 0x100 wird zyklisch auf CAN-1 gesendet (alle 250 ms). 
Wird eine variable Spannung an den Eingang Ain-0 angelegt, ändert 
sich der Inhalt der Nachricht in den Bytes 0 und 1 (10-Bit-Wert). Da-
bei ist Byte0/Bit0 das LSB, Byte1/Bit1 das MSB (Intel-Datenformat). 

Sofern man über das PCAN-Explorer Add-in Instruments Panel (Art.-
Nr. IPES-005088) verfügt, lässt sich dieser Wert grafisch, beispiels-
weise mit einem Bargraph-Control, darstellen (siehe Aufgabe 1h). 
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4.12 Aufgabe 2d: Setzen der analogen 
Ausgänge entsprechend einer 
empfangenen CAN-Nachricht 

Um im folgenden Beispiel den analogen Ausgang Aout-0 kon-
trollieren zu können, ist ein Spannungsmessgerät (Voltmeter 
bzw. DMM) an diesen Ausgang anzuschließen. 

1. Öffnen Sie die Konfiguration der Aufgabe 2c und speichern 
diese unter Aufgabe 2d auf ihrem PC. 

2. Ändern Sie im Tab General das CAN-Signal in Aout0 um. 

3. Schalten Sie im Tab Config0 I/O die CAN-Nachricht auf 
Receive um und weisen dem CAN-Signal die I/O-Funktion 
AOut-Level und der I/O-Number AOut 0 zu. 

 

4. Speichern Sie die Konfiguration als Aufgabe 2d auf ihrem 
PC. 

5. Übermitteln Sie die Konfigurationsdatei an das PCAN-MIO-
Modul über den CAN-Bus (Upload). 

Wird eine Nachricht 0x100 an das PCAN-MIO-Modul gesendet, in 
der in Byte0/1 ein 10-Bit-Wert codiert ist (Intel-Format), kann man 
am analogen Ausgang Aout-0 des PCAN-MIO-Moduls eine 
äquivalente Spannung zwischen 0 und 10 V messen. 

Sofern man über das PCAN-Explorer Add-in Instruments Panel (Art.-
Nr. IPES-005088) verfügt, lässt sich dieser Wert mit einem 
Schieberegler-Control bedienen (siehe Aufgabe 1h). 
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4.13 Aufgabe 2e: Schalten des 5 V-Ausgangs 

Zur Versorgung von Sensoren liefert das PCAN-MIO-Modul eine 
schaltbare 5-Volt-Hilfsspannung, die mit maximal 200 mA belastet 
werden kann. 

Um im folgenden Beispiel den Schaltzustand der Hilfsspannung 
kontrollieren zu können, ist ein Spannungsmessgerät (Voltmeter 
bzw. DMM) an diesen Ausgang anzuschließen. Alternativ kann 
eine Leuchtdiode mit passendem Vorwiderstand (ca. 390 Ohm) 
gegen GND angeschlossen werden. 

1. Öffnen Sie die Konfiguration der Aufgabe 2b und speichern 
diese unter Aufgabe 2e auf ihrem PC. 

2. Ändern Sie im Tab General das CAN-Signal in 5Vout um. 

3. Weisen Sie im Tab Config0 I/O dem CAN-Signal die I/O-
Funktion Special Out und der I/O-Number Enable 5V zu. 

 

4. Speichern Sie die Konfiguration als Aufgabe 2e auf ihrem 
PC. 
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5. Übermitteln Sie die Konfigurationsdatei an das PCAN-MIO-
Modul über den CAN-Bus (Upload). 

Wird eine Nachricht 0x100 an das PCAN-MIO-Modul gesendet, in 
der Byte0/Bit0 =1 ist, wird der 5 V-Ausgang aktiviert. Ist Byte0/Bit0 = 
0, wird der 5 V-Ausgang deaktiviert. 

4.14 Aufgabe 3a: CAN-Signal mit 
Funktionsblock Kennlinie bearbeiten 

Die Kühlmitteltemperatur bzw. Motortemperatur soll zwischen 80 °C 
und 105 °C als konstant 90 °C angezeigt werden (um Schwankungen 
zu glätten bzw. den Fahrer nicht zu beunruhigen). Sollte die Motor-
temperatur aufgrund eines Defekts außerhalb des genannten Be-
reichs geraten, soll wieder die echte Temperatur angezeigt werden. 

 

Hierzu eignet sich der Funktionsblock Kennlinie, der den herein-
kommenden echten Messwerten vom Motor (Rohwert) umrech-
net und so ein Plateau für die Anzeige bildet. Der umgerechnete 
Wert wird in einer separaten CAN-Nachricht ausgegeben. 

1. Legen Sie eine leere Konfigurationsdatei mit File > New an. 

2. Definieren Sie zwei CAN-Nachrichten mit je einem 8-Bit-
CAN-Signal. 
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 CAN-ID: 0x100 für den ankommenden Rohwert; 0x200 für den 
ausgehenden Anzeigewert (mit Plateau) 

 DLC: 1 (die Nachrichten sind je 1 Byte lang) 

 Enable: Ja 

 

 Bit Length: 8 

 Signed: Nein, kein Vorzeichen 

3. Legen Sie eine neue Konfiguration innerhalb der Konfigura-
tionsdatei an. Wählen Sie den Menüpunkt Edit > New 
Configuration aus. 

4. Importieren Sie anschließend den global definierten Bus mit 
allen Nachrichten und Signalen. Das Kontextmenü öffnen 
(rechte Maustaste) und Add defined bus auswählen. 



PCAN-MIO – Konfigurations-Tutorial 
 

47 

 

 Direction: 0x100 wird empfangen (Receive), 0x200 wird gesendet 
(Transmit). 

 Enable: Ja 

 Period: Die Nachricht mit der manipulierten Kühlmitteltempera-
tur wird alle 500 ms gesendet. 

 

 I/O-Function, I/O-Number: Das Signal Rohwert aus der Nachricht 
0x100 wird in die Variable #0 transferiert, das Ergebnis (in der 
Variablen #1) wird in die Nachricht 0x200 geschrieben. 

Zur Umrechnung des Rohwerts (Variable #0) in den Anzeigewert 
(Variable #1) wird eine Kennlinie definiert und es bedarf eines Funk-
tionsblocks, der diese Kennlinie aufruft. In der folgenden Tabelle 
sind die Knickpunkte der Kennlinie abgelegt. Bei Zwischenwerten 
wird das Ergebnis linear interpoliert: 
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 X Y 

Punkt 0 X=0 Y=0 

Punkt 1 X=75 Y=75 

Punkt 2 X=85 Y=90 

Punkt 3 X=105 Y=90 

Punkt 4 X=110 Y=110 

Punkt 5 X=255 Y=255 
 

Diese Werte werden nun dem PCAN-MIO-Modul bekanntgegeben. 

5. Doppelklicken Sie am linken Bildrand im Navigations-
Fenster die Konfiguration Config0 an. Wählen Sie den Tab 
Characteristic curve aus. Öffnen Sie das Kontextmenü 
(rechte Maustaste) und wählen Sie Add Record. 

Es erscheint eine Tabellenzeile, die eine Kennlinie 
repräsentiert und mit Werten befüllt werden muss. 

 

 Curve-ID: 13 (eine willkürlich gewählte Nummer) 

 Point Count: 6 (Anzahl der X/Y-Wertepaare) 

 Wertepaare 0… 5: Die Kennlinie (Werte aus obiger Tabelle). 
Weitere Wertepaare werden nicht benötigt und enthalten 0 

Wichtiger Hinweis: Die X-Werte müssen aufsteigend sortiert 
eingetragen werden! 

Zuletzt muss dafür gesorgt werden, dass der Rohwert zu 
den X-Koordinaten der Kennlinie gelangt, und der sich 
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ergebende Y-Wert in die 32-Bit-Variable #1 geschrieben 
wird, um auf den CAN-Bus übermittelt zu werden. Dazu wird 
ein Funktionsblock benötigt, der die Handhabung der Kenn-
linie übernimmt. 

6. Klicken Sie auf den Tab Function blocks um einen 
Funktionsblock anzulegen. Öffnen Sie das Kontextmenü 
(rechte Maustaste) und wählen Sie Add Record. 

Es erscheint eine Tabellenzeile, die einen Funktionsblock 
repräsentiert und mit Werten befüllt werden muss. 

Grundsätzlich hat jeder Funktionsblock zwei Eingänge 
(Operanden) und einen Ausgang (Ergebnis), jeweils 
bestehend aus I/O-Typ und I/O-Nummer, weiterhin gibt es 
einen Hauptschalter (Enable) und eine Zykluszeit (wie oft 
wird das Ergebnis berechnet, in ms). 

Hinweis: Bei der Characteristic Curve wird der zweite Eingang 
nicht benutzt. 

7. Tragen Sie folgende Parameter in den Funktionsblock ein. 

 

 Function Code: Characteristic Curve (die Kennlinien-Bedien-
Funktion) 

 Enable: Ja, dieser Block soll aktiv sein 

 Input1 I/O Function: FFh 32bit-Variable 

 Input1 I/O Number: 0 (der X-Wert ist in der 32-Bit-Variablen #0) 

 Input2 I/O Function: F0h Special In (nicht benutzt) 
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 Input2 I/O Number: none (nicht benutzt) 

 Output I/O Function: FFh 32bit Variable 

 Output I/O Number: 1 (das Y-Ergebnis kommt in die 32-Bit-
Variable #1) 

 Parameters: 13 (die Nummer der bereits definierten Kennlinie). 
Es öffnet sich folgendes Fenster:  

 

 Tragen Sie unter Value die Nummer der bereits definierten 
Kennlinie ein und bestätigen Sie mit Close 

 Cycle time: 100 (die Berechnung des Rohwerts findet alle 100 ms 
statt) 

8. Speichern Sie die Konfiguration als Aufgabe 3a auf ihrem 
PC. 

9. Übermitteln Sie die Konfigurationsdatei an das PCAN-MIO-
Modul über den CAN-Bus (Upload). 

Ein kontinuierlich steigender Eingangswert (Nachricht 0x100) wird 
mit einem Plateau versehen und ausgegeben (Nachricht 0x200). 

Sofern man über das PCAN-Explorer Add-in Instruments Panel (Art.-
Nr. IPES-005088) verfügt, lassen sich die Werte grafisch darstellen 
(siehe Aufgabe 1h). 
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4.15 Aufgabe 3b: Schwellwert mit Hysterese 

Ausgehend von der Thematik aus Aufgabe 3a soll beim Überschrei-
ten einer Kühlmitteltemperatur von 123 °C eine Warnlampe ange-
hen und beim Unterschreiten von 118 °C wieder ausgehen. Dafür ist 
der Funktionsblock Hysterese geeignet. 

Die Warnlampe wird an Dout-0 angeschlossen. Sinnvoll ist eine 
Reihenschaltung aus Leuchtdiode und passendem Vorwider-
stand (z. B.: ca. 1,5 kOhm) gegen GND. 

1. Öffnen Sie die Konfiguration der Aufgabe 3a und speichern 
diese unter Aufgabe 3b auf ihrem PC. 

2. Um einen weiteren Funktionsblock anzulegen klicken Sie auf 
den Tab Function blocks. Öffnen Sie das Kontextmenü 
(rechte Maustaste) und wählen Sie Add Record. 

3. Tragen Sie in den Funktionsblock folgende Parameter ein: 
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 Function Code: Hysteresis (die Schwellwertschalter mit 
Hysterese-Funktion) 

 Enable: Ja, dieser Block soll aktiv sein 

 Input1 I/O Function: FFh 32bit Variable 

 Input1 I/O Number: 1 (man kann auch 0 verwenden, da in 
diesem Temperaturbereich die Kurven identisch verlaufen) 

 Input2 I/O Function: F0h Special In (nicht benutzt) 

 Input2 I/O Number: none (nicht benutzt) 

 Output I/O Function: Dout-0 (ein Hardware-Ausgang mit High-
Side-Treiber) 

 Parameter: Lower Threshold: 118 °C (Ausschaltpunkt); Upper 
Threshold: 123 °C (Einschaltpunkt); Unterhalb Lower Threshold 
(LowOutValue) wird der Ausgang Dout-0 inaktiv (0); Oberhalb 
Upper Threshold (HighOutValue) wird der Ausgang Dout-0 aktiv 
(1) 

 Cycle time: 100 (die Berechnung des Rohwerts findet alle 100 ms 
statt) 

4. Speichern Sie die Konfiguration als Aufgabe 3b auf ihrem 
PC. 

5. Übermitteln Sie die Konfigurationsdatei an das PCAN-MIO-
Modul über den CAN-Bus (Upload). 
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Wird in der Nachricht 0x100 ein Temperaturwert > 123 °C an das 
PCAN-MIO-Modul gesendet, wechselt der Ausgang Dout-0 auf 1 
(Leuchtdiode an). 

Wird in der Nachricht 0x100 ein Temperaturwert < 118 °C an das 
PCAN-MIO-Modul gesendet, wechselt der Ausgang Dout-0 auf 0 
(Leuchtdiode aus). 

Tipp: Jeder 32-Bit-Variablen (und auch anderen Ressourcen) 
kann ein lesbarer Name zugewiesen werden. Gehen Sie dazu 
folgendermaßen vor: 

1. Ausgehend vom Tab Function blocks, wählen Sie den 
Menüpunkt Edit > I/O-Funktion aus. 

Es öffnet sich folgendes Fenster: 

 

Hier wird die 32-Bit-Variable #0 umbenannt in Rohwert und 
die Variable #1 in Anzeigewert. 
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Hier wird die DOut Level-Variable #0 umbenannt in Warn-
lampe. 

Ab sofort kann man in der Konfiguration mit diesen Namen arbei-
ten, was Fehler durch Verwechslung einer Variablennummer erheb-
lich reduziert. 

4.16 Aufgabe 3c: Senden nur, wenn sich ein 
Signal ändert 

1. Öffnen Sie die Konfiguration der Aufgabe 2c und speichern 
diese unter Aufgabe 3c auf ihrem PC. 

2. Setzen Sie im Tab Config0 I/O die Senderate (Period) der 
CAN-Nachricht 0x100 von 250 ms auf 0 ms. 

Damit wird die CAN-Nachricht nicht mehr zyklisch gesendet. 
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 Period: 0 ms 

 Event Time: 50 ms (falls der Trigger permanent auslöst, ist dies 
der Mindest-Sendeabstand. So wird die Buslast begrenzt) 

Das CAN-Signal in dieser Nachricht bleibt unverändert. 

 

3. Die Triggerbedingung, die das Senden auslöst, wird im 
Konfigurationsfenster definiert. 

4. Doppelklicken Sie am linken Bildrand im Navigations-
Fenster die Konfiguration Config0 an. Wählen Sie den Tab 
Event based messaging aus. Öffnen Sie das Kontextmenü 
(rechte Maustaste) und wählen Sie Add Record. 

Falls der Trigger zuschlägt, soll auf CAN-0 die definierte 
Nachricht 0x100 gesendet werden. Trigger/Auslöser soll ein 
analoger Pegel sein, der an Ain 0 anliegt. Wenn sich dieser 
Pegel um einen Betrag ändert, dann soll die ID 0x100 ge-
sendet werden. 
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 Bus: Bus_0 

 Message: 0x100 

 I/O Function: 90h Ain Level 

 I/O No: AIn-0 

 Event Type: Signal change by threshold 

 Threshold: 5 

 Enable: Ja 

5. Speichern Sie die Konfiguration als Aufgabe 3c auf ihrem 
PC. 

6. Übermitteln Sie die Konfigurationsdatei an das PCAN-MIO-
Modul über den CAN-Bus (Upload). 

Wird ein Potentiometer (wie in Aufgabe 2c erläutert) an Ain-0 ange-
schlossen und betätigt, dann sendet das PCAN-MIO-Modul eine 
Nachricht 0x100, die den Analogwert enthält. 

Die Sendehäufigkeit kann mit dem Parameter Threshold variiert 
werden. Dieser Schwellwert sollte allerdings größer 1 sein, da das 
LSB des A/D-Wandlers flackern kann, falls der Potentiometer an der 
Grenze zwischen zwei Digits steht. 

Das Signal das den Trigger auslöst (hier: Ain 0), muss in der Sende-
nachricht definiert sein, sonst wird die Nachricht nicht gesendet. 
Wenn man es nicht übertragen will, kann man seine Länge auf 0 
setzen. 
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4.17 Aufgabe 4a: Setzen der CAN-Bitrate 
(Defaultwerte) 

Abhängig von den bestückten CAN-Transceivern stellt das PCAN-
MIO-Modul selbsttätig folgende Bitraten ein: 

Interface-Typ CAN-Transceiver Default-Bitrate WakeUp-fähig 

HS TJA-1041 (default) 500 kbit/s ja 

HS opto TJA-1040 500 kbit/s nein 

HS TJA-1040 500 kbit/s nein 

LS-DW TJA-1054 125 kbit/s ja 

LS-SW TH-8056 33,3 kbit/s ja 
 

Diese Werte können beim Starten des PCAN-MIO-Moduls durch 
geeignete Einträge in der Konfiguration, Tab Default values for data 
objects überschrieben werden. 
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Hinweis: Da die PC-Software PPCAN-Editor 2 nicht weiß, 
welche Transceiver im Gerät PCAN-MIO verbaut sind, werden 
alle denkbaren Übertragungsraten angeboten. Es ist also darauf 
zu achten, dass sinnvolle Werte verwendet werden, z. B. bei LS-
SW ist die maximale Bitrate 83,3 kbit/s, bei HS-TJA1040 ist die 
minimale Bitrate 40 kbit/s. 

4.18 Aufgabe 5a: Ausgabe der Modul-ID 
(Diagnose) 

Die Modul-ID ist ein 4-Bit-Wert, der ab Werk auf 0 eingestellt ist und 
per Drehschalter verändert werden kann. Sie hat verschiedene 
Funktionen, z. B. wählt sie aus einer Datei mit mehreren Konfigura-
tionen die der Schalterstellung entsprechende aus. Bei unerklärli-
chem Verhalten einer neuen Konfiguration ist einer der ersten 
Debug-Schritte daher das Feststellen der Modul-ID. Es könnte 
nämlich sein, dass man die eine Konfiguration erfolglos editiert, 
weil jedes Mal die andere ausgeführt wird. 

Die Aufgabe ist nun das Senden einer CAN-Nachricht mit der ID 
0x280, Länge 8 Bytes auf den Bus CAN-0. Diese Nachricht ent-
hält das Signal ModuleId, dass die derzeit eingestellte Modul-ID 
anzeigt. 

1. Anlegen einer neuen Datei und definieren einer Sendenach-
richt Diagnosis, die ein CAN-Signal mit der Modul-ID ent-
hält. 

 

 Nachrichtenname: Diagnosis 
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 CAN-ID: 0x280 

 DLC: 4 

 Enable: Ja 

2. Anlegen eines neuen CAN-Signals ModuleId. 

 

 Signalname: ModuleId 

 Bit Length: 4 

3. Importieren der Nachricht inklusive des CAN-Signals in die 
Konfiguration und Eintragen der Parameter. 

 

 Direction: Transmit 

 Enable: Ja 

 Period: 250 ms 

4. Befüllen des Signals mit der virtuellen Resource Module-ID. 
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 I/O-Function: F0h Special In 

 I/O-Number: Module-ID 

 Enable: Ja 

5. Speichern Sie die Konfiguration als Aufgabe 5a auf ihrem 
PC. 

6. Übermitteln Sie die Konfigurationsdatei an das PCAN-MIO-
Modul über den CAN-Bus (Upload). 

Es wird die zyklische Nachricht Diagnosis (mit der ID 0x280) alle 250 
ms gesendet, die das Signal ModuleId enthält. 

Hinweis: Eine Änderung der Modul-ID ist in der CAN-Nachricht 
sofort sichtbar, wird aber erst nach Reset des Geräts aktiv (z. B. 
durch Power Off/On). 
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4.19 Aufgabe 5b: Ausgabe der Firmware-
Version (Diagnose) 

Die Firmware-Version des PCAN-MIO-Moduls kann zu 
Diagnosezwecken ausgelesen werden. 

1. Öffnen Sie die Konfiguration der Aufgabe 5a und speichern 
diese unter Aufgabe 5b auf ihrem PC. 

2. Fügen Sie 3 weitere CAN-Signale (FirmwareVersionMain, 
FirmwareVersionSub, FirmwareBuildNo) hinzu und setzen 
Sie die Parameter wie folgt. 

 

 Im zweiten Nachrichten-Byte (Byte1) wird der 8-Bit-Wert 
FwVersionMain übertragen 

 Im dritten Nachrichten-Byte (Byte2) wird der 8-Bit-Wert 
FwVersionSub übertragen 

 Im vierten Nachrichten-Byte (Byte3) wird der 8-Bit-Wert 
FwBuildNumber übertragen 

3. Importieren der drei neuen Signale in die Konfiguration. Das 
Kontextmenü öffnen (rechte Maustaste) und Add defined 
Variable auswählen. 

Befüllen Sie diese mit Werten (weisen Sie die virtuellen 
Modulresourcen zu). 
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4. Speichern Sie die Konfiguration als Aufgabe 5b auf ihrem 
PC. 

5. Übermitteln Sie die Konfigurationsdatei an das PCAN-MIO-
Modul über den CAN-Bus (Upload). 

Die zyklische Nachricht Diagnosis mit der ID 0x280 enthält jetzt auch 
Informationen zur Firmware-Version. 
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4.20 Aufgabe 6: CAN-Nachrichten auf 
Anforderung 

Ausgehend von Aufgabe 5b sollen die Diagnose Information auf 
Anforderung von extern ausgegeben werden (RTR = Remote 
Transmission Request). 

1. Öffnen Sie die Konfiguration der Aufgabe 5a und speichern 
Sie diese unter Aufgabe 5b auf ihrem PC. 

2. Umstellen der CAN-Nachricht auf Transmission Request 
durch Setzen des RTR-Häkchens in der Nachricht (damit nur 
auf Anforderung gesendet wird). 

 

 RTR: Ja (aktivieren Remote Transmission Request) 

3. Importieren Sie die CAN-Signale in die Konfiguration. Set-
zen Sie den Sendezyklus auf 0. Damit wird die Nachricht 
nicht mehr zyklisch gesendet. 

 

 Period: 0 (nicht mehr zyklisch senden) 
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4. Speichern Sie die Konfiguration als Aufgabe 5b auf ihrem 
PC. 

5. Übermitteln Sie die Konfigurationsdatei an das PCAN-MIO-
Modul über den CAN-Bus (Upload). 

Die Nachricht Diagnosis mit der ID 0x280 wird nur einmal gesendet, 
wenn vorher eine Anforderung mit ID 0x280 und Nachrichtenlänge 
= 0 empfangen wurde. 

4.21 Aufgabe 7: Der Sleep-Mode 
(Energiesparen) 

Das Modul PCAN-MIO kann sich (konfigurierbar) selbst abschalten, 
um Strom zu sparen. Dieser sogenannte Sleep-Mode tritt ein: 

 wenn (bei verbauten wake-up-fähigen CAN-Transceivern) keine 
CAN-Nachricht mehr eintrifft, die den Transceiver wecken 
könnte 

 und der Hardware-Eingang "WakeUp" keinen Vbat-Pegel erkennt 
(z. B. Klemme 15) 

 und die interne Variable SELFHOLD auf 0 gesetzt ist. 

Nach dem Wecken durch entweder eine entsprechend gestaltete 
CAN-Nachricht (bei verbauten wake-up-fähigen CAN-Transceivern) 
oder einen Vbat-Pegel am Hardware-Eingang WakeUp ist die 
interne Variable SELFHOLD auf 1 gesetzt und hält das Modul bis auf 
weiteres in Betrieb. 

Voraussetzung für das Wecken ist, dass der entsprechende CAN-
Bus mit einem wake-up-fähigen Transceiver bestückt ist, z. B. LS-
SW. 
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Interface-Typ CAN-Transceiver Default-Bitrate WakeUp-fähig 

HS TJA-1041 (default) 500 kbit/s ja 

HS opto TJA-1040 500 kbit/s nein 

HS TJA-1040 500 kbit/s nein 

LS-DW TJA-1054 125 kbit/s ja 

LS-SW TH-8056 33,3 kbit/s ja 
 

Falls eine CAN-Nachricht nicht mehr empfangen wird und ein 
Timeout-Wert vereinbart ist, werden alle enthaltenen CAN-Signale 
auf einen Default-Wert zurückgesetzt. Falls im Tab Default values for 
data objects nichts anderes angegeben wird, ist der  
Default-Wert = 0. 

Auf dem Fahrzeugbus gibt es üblicherweise ein zyklisches Signal, 
das die Stellung des Zündschlüssels wiedergibt (Klemme 15 bzw. 
PowerMode). Mit Empfang eines WakeUp-Frames vom Fahrzeug 
(hoher Sendepegel) wacht das Modul auf und reagiert dann auf den 
Erhalt des CAN-Signals Zündung ein. Solange das CAN-Signal Zün-
dung ein = 1 ist, soll das Modul wachbleiben, bei Zündung aus = 0 
soll das PCAN-MIO-Modul um 6 Sekunden verzögert einschlafen, 
unabhängig von anderen gesendeten Nachrichten. Das Signal 
Zündung ein = 1 triggert/retriggert ein Monoflop, das 6 Sekunden 
nach dem letzten Trigger abschaltet. Solange der Signalwert = 1 ist, 
ist der Countdown des 6 Sekunden-Intervalls ausgesetzt. Zum 
Auslösen ist es also wichtig dafür zu sorgen, dass der Signalwert 0 
wird. Dies wird erreicht, indem man entweder die Nachricht mit 
dem Signalwert = 0 zum PCAN-MIO-Modul sendet oder die CAN-
Nachricht überhaupt nicht mehr sendet (der sogenannte Timeout-
Fall, er setzt alle Signale der CAN-Nachricht auf 0, s. o.). 

1. Anlegen einer neuen Datei und Definieren einer Empfangs-
nachricht, die ein CAN-Signal zum Zündschloss-Status ent-
hält. 
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 Nachrichtenname: IgnitionState 

 CAN-ID: 0x101 

 DLC: 1-Byte 

 Enable: Ja 

 

 Signalname: KeyOn 

 Bit Length: 1-Bit 

 Byte/Bit Position: 0, 0 (im ersten Byte rechts) 

 Signed: Nein, es ist nur 1-Bit 

2. Legen Sie eine neue Konfiguration innerhalb der Konfigura-
tionsdatei an. Anschließend den global definierten Bus mit 
allen Nachrichten und Signalen importieren. 
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 Direction: Receive 

 TimeOut: 1000 ms (danach geht das Signal auf Defaultwert 0) 

 

 I/O-Function: FFh 32bit Variable 

 I/O-Number: 0 

 Scale: 1 

 Offset: 0 

 Enable: Ja 

3. Klicken Sie am linken Bildrand im Navigations-Fenster die 
Konfiguration Config0 an, und klicken Sie auf den Tab 
Function blocks um einen Funktionsblock anzulegen. 

4. Legen Sie einen Funktionsblock Monoflop an, der die 
Selbsthaltung ausschaltet (5 Sekunden, nachdem die 
Variable 0 den Wert 0 angenommen hat). 

 

 Function Code: Monoflop 

 Enable: Ja 

 Input1 I/O-Function: FFh 32bit Variable 
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 Input1 I/O-Number: 0 

 Input2 I/O-Function: nicht benutzt 

 Input2 I/O-Number: nicht benutzt 

 Output I/O-Function: 70h SpecialOut (eine virtuelle 
Modulresource) 

 Output I/O-Number: Selfhold 

 Parameter: 5 s, alles weitere kann in der Referenz 
nachgeschlagen werden 

 Cycle Time: 100 ms 

5. Speichern Sie die Konfiguration als Aufgabe 5b auf ihrem 
PC. 

6. Übermitteln Sie die Konfigurationsdatei an das PCAN-MIO-
Modul über den CAN-Bus (Upload). 

5 Sekunden, nachdem das Signal von 1 nach 0 wechselt (bzw. 6 
Sekunden, nachdem die Nachricht ausbleibt), wird dir Selbsthaltung 
des Netzteils abgeschaltet und das Modul geht in den Sleepmode. 
Sofern ein weckfähiger Transceiver bestückt ist, kann mit einer 
CAN-Nachricht das PCAN-MIO-Modul wieder aktiviert werden. 
Alternativ kann die WakeUp-Leitung mit High-Pegel beaufschlagt 
werden. 
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4.22 Aufgabe 8a: Multiplexer-Nachricht 
automatisch senden 

Information: Das Beispiel sendet eine CAN-Nachricht mit variieren-
den Variablen, die durch einen Multiplexer (Zwischenadressierung) 
angesteuert werden. 

Definition: Die Beispielnachricht hat folgende Eckdaten: 

 CAN-ID: 100h 

 Länge: 3 Bytes 

 Bit-Belegung (Variablen): 

Byte Nr./ 
Startbit 

Bits Benennung Verwendung 

0/0 8 Mux-Val Multiplexer 

1/0 8 Data_Common Variable unabhängig vom Multiplexer 
(immer vorhanden) 

2/0 8 Data_Mux-is-2 
Data_Mux-is-4 
Data_Mux-is-6 

Veränderliche Variable abhängig vom 
Multiplexerwert im Datenbyte 0 (hier: 
2, 4 oder 6) 

 

Aktion: Im Fenster CAN Objects unter General die neue CAN-
Nachricht 100h mit den oben angegebenen Eckdaten anlegen. Dabei 
für die Variablen in den Spalten Multiplexer Type und Multiplexer 
Value die folgenden Angaben machen: 

Benennung Multiplexer Type / 
Value 

Erläuterung 

Mux-Val Multiplexer Wert bestimmt, welche Multiplexed-
Variable verwendet wird. 

Data_Common None Variable wird unabhängig vom 
Multiplexer immer in dieser CAN-
Nachricht verwendet. 

Data_Mux-Is-2 Multiplexed / 2 

Data_Mux-Is-4 Multiplexed / 4 

Data_Mux-Is-6 Multiplexed / 6 

Bei den Multiplexer-Werten 2, 4 und 6 
wird die jeweilig zugeordnete Variable 
verwendet. 
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Bemerkung: Für die Angabe in der Spalte Multiplexer Type gibt es 
die folgenden Möglichkeiten: 

 Multiplexer: Die Variable enthält den Multiplexerwert (Datentyp 
Unsigned). Dieser Multiplexer-Typ darf nur einmal in einer 
Nachricht verwendet werden und muss in der Liste vor 
Variablen-Definitionen vom Typ Multiplexed stehen. 

 None: Diese Variable wird in jeder Sendenachricht verwendet, 
unabhängig vom Multiplexer-Wert. 

 Multiplexed: Die Variable wird nur gesendet, wenn der Wert 
Multiplexer Value dem aktuellen Multiplexer-Wert aus Mux-Val 
entspricht. 

Information: Den Data-Variablen werden im Folgenden noch feste 
Testwerte für die Übertragung zugewiesen. Außerdem soll die 
Nachricht alle 200 ms gesendet werden. Dies geschieht in der 
gerätespezifischen Konfiguration (hier: Config0 I/O). 

Aktion: Falls noch nicht vorhanden, dem PPCAN-Editor-Projekt eine 
neue Konfiguration mit Edit > New Configuration hinzufügen und 
dabei den Modultyp PCAN-MIO (32-Bit) auswählen (siehe auch 
Seite 13). 

Im Kontextmenü (Rechtsklick) der CAN-Nachricht Msg_100 den 
Eintrag Add Symbol to Configuration und dann Config0 I/O wählen. 
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Definition: In der Konfiguration Config0 müssen nun in den 
Fenstern CAN Objects als auch Config0 Einstellungen für die CAN-
Nachricht und die enthaltenen Variablen vorgenommen werden. 
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Bemerkung: Der Multiplexer-Variable Mux-Val ist die Ressource 
Special In (F0h)/none zugeordnet. Das heißt, dass sie automatisch 
mit jedem Sendevorgang der CAN-Nachricht (hier alle 200 ms) auf 
den Wert der nächsten Multiplexed-Variable gesetzt. Die 
Multiplexed-Variablen werden so der Reihe nach gesendet. 

Information: Damit sind die Konfigurationsarbeiten dieser Aufgabe 
abgeschlossen und das Projekt kann auf das PCAN-MIO-Modul 
übertragen werden. 

4.23 Aufgabe 8b: Multiplexer-Nachricht auf 
Anfrage senden 

Information: Alternativ zum automatischen Durchiterieren der 
Multiplexed-Variablen kann eine andere Ressource verwendet 
werden, zum Beispiel eine 32-Bit-Variable, die per CAN beschrieben 
wird. So wird der Multiplexerwert von außen bestimmt. 

Anwendungsmöglichkeit: Diverse Parameter sollen per CAN 
abgefragt werden, jedoch steht nur eine CAN-ID zum Senden zur 
Verfügung. Jedem Parameter wird einem Multiplexer-Wert 
zugeordnet. Der Multiplexer-Wert wird durch eine gesonderte 
Empfangsnachricht eingestellt und entsprechend als Antwort die 
Multiplexer-CAN-Nachricht gesendet. 

In dieser Aufgabe soll der Empfang der CAN-Nachricht 1FFh (1 Byte) 
das Senden bereits vorhandenen Nachricht 100h auslösen. Dabei 
wird das Datenbyte von 1FFh als Multiplexerwert in 100h 
verwendet. 

Bemerkung: Diese Aufgabe basiert auf der vorherigen 9a. 
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Aktion: Im Fenster CAN Objects unter General zusätzlich die CAN-
Nachricht 1FFh mit diesen Eckdaten anlegen: 

 CAN-ID: 1FFh (Trigger_Msg_100) 

 Länge: 1 Byte 

 Bit-Belegung (Variablen): 

Byte Nr./ 
Startbit 

Bits Benennung Verwendung 

0/0 8 Request_MuxData Wert für den Multiplexer in ID 100h 
 

Unter Config0 I/O die Nachricht als Empfangsnachricht (Receive) 
einrichten und die Variable Request_MuxData der internen 32-Bit-
Variablen 255 (I/O-Funktion FFh) zuweisen. 

Ebenfalls unter Config0 I/O die bereits vorhandene CAN-Nachricht 
Msg_100 (100h) so abändern, dass sie nicht mehr regelmäßig 
gesendet wird. Dazu die Zykluszeit (Period) auf 0 setzen. Die 
Variable Mux-Val so abändern, dass sie ihren Wert nun aus der 
internen 32-Bit-Variablen 255 (I/O-Funktion FFh) erhält. 

Wie in Aufgabe 1c (Seite 21) wird im Message Gateway der Config0 
ein neuer Eintrag angelegt, der mit dem Empfang der Nachricht 
Trigger_Msg_100 das Senden der Nachricht Msg_100 auslöst. 

 

Information: Damit sind die Konfigurationsarbeiten dieser Aufgabe 
abgeschlossen und das Projekt kann auf das PCAN-MIO-Modul 
übertragen werden. 
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4.24 Aufgabe 9: Bonusaufgaben 

 Es kann eine Konfiguration erstellt werden, die auf Dout-0 eine 
Pulswelle mit definierter Frequenz und definiertem Tastverhält-
nis ausgibt. Mit einem geeigneten Messgerät (Frequenzzähler, 
Oszilloskop) kann der Aufbau verifiziert werden. Man könnte die 
Frequenz oder das Tastverhältnis via CAN-Nachricht oder mit 
einer analogen Spannung proportional steuern 

 Es kann eine Konfiguration erstellt werden, die auf Din-0 eine 
ankommende Pulswelle bzgl. Frequenz und Tastverhältnis aus-
wertet. Mit einem geeigneten Signalgenerator kann der Aufbau 
verifiziert werden. Man könnte die Frequenz oder das Tastver-
hältnis via CAN-Nachricht oder als proportionale analoge Span-
nung ausgeben 

 Es kann eine Konfiguration erstellt werden, die (abhängig z. B. 
von einem Din-Pegel) ein 32-Bit-CAN-Signal wahlweise durch 2 
unterschiedliche Kennlinien leitet. Es gibt auch eine Kennlinien-
schar, deren Z-Parameter die zu verwendende Kennlinie be-
stimmt. Liegt der Z-Wert zwischen zwei Kennlinien, wird das 
Ergebnis linear interpoliert. 

 Regelungstechnik: Ein weites Feld… 
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